HealthFile Quick Start Documentation

Introduction:

HealthFile allows for comprehensive tracking of personal health information and history for personal
use or physician use from any Palm OS handheld and Windows PC. This document provides
information on the handheld software, as the PC software has its own complete help file system. You
may want to print this document for easier reference.

Installation:

To install the software, download the setup file (usually HealthFilePalm_Setup.exe) to your PC. Then,
double click the .exe setup file to start the PC installer. The installer will install the PC software first.
When the software is first run after installing, the handheld software will be installed.

Registration:

The software is initially installed as a trial version. After purchasing, a 5-digit registration code is
provided. This 5-digit code is entered in the blank area on the startup screen on the handheld or on
the PC software from the Help / Register menu. Once the registration code is entered on either the
handheld or PC, the registration code will be transferred to the other version when synced. The
registration code unlocks the full version features. No additional installation is required.

Getting Started:

The following screens and descriptions explain many of the features in HealthFile. The software was
designed to be easy and intuitive, so it will be easy to get started. This documentation will help explain
some of the advanced features.

To start the software on the handheld, tap the HealthFile icon. On Palm OS handhelds, this icon may
be in the Unfiled category. From the Home (icon) screen on your handheld, tap the drop down list in
the upper right corner, then select Unfiled to list any uncategorized icons. A category can be assigned
to the icon to make it easier to find. Consult your handheld manual for how to categorize icons.
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Main List Screen:

Saved Personal Profiles:
Smith, Joe

( Mew ) (Prefs ) Find:

Profile Topics Screen:

] [ Medications )
) ( Vaccinations )
) ( Tests )
) (Blood Pressure )
J ([ Weight )
(lnesses,etc. ) [ Glucose )
(‘Surgeries, etc. ) [ Cholesterol )
(" Appointments ] (Family History )

[ Personal
( Legal

( Insurance
( Contacts
( Allergies

Topic Screens:

ona
First: My,
Birthdate:
Gender: ™M
wSSN:
*Home Ph:
Address: [+

Last:Name
Age:
Blood Type: *B-

Typical Personal Values:
Pulse: BP:
Height: Weight:
Cholesterol:

Save Cancel

Name: My Name
Marital Status: ™
Organ Donor: ™

Wwill: -
Living Will: M
Power of Attorney: ™™ .. =

Next of Kin:*

Notes:

Upon startup, the list of saved profiles is displayed. Simply tap any record
in the list to view the profile

Tap the New button at the bottom of the screen to create a new profile. A
profile can be created for every member of a family, including each child.

Also, the Find Area can be used to jump to a certain profile by entering
the first few letters in the name.

Tap the Prefs buttons to view the Preferences screen.

The profile topics screen a list of buttons for each information topic.
Simply tap a topic to view or enter information for that topic.

To delete the current personal profile, tap the Delete button.

To go back to the list of profiles, top the Back button.

There are many topic screens allowing for a great amount of information
to be stored for each profile.

Personal: store basic personal information including birthday, address,
normal health values.

Legal: store organ donor status, will information, and other legal type
items.
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Company: ™™

Type: ™

Group #:

Policy #:

Date:w
Phone:

FAX:

Address: [»

Notes:

Save Cancel

wFirst: Last:

Home Ph:

Work Ph:

Mobile Ph:

Address: [

Notes: [

Allergies

Allergy:

Reaction: [

Start Date: ™

Notes: [»

lliness/ Condition: [+

Symptoms: [»

Onset Date: ™
Cured Date: ™
Diagnosis:

Treatment:

Physician:
Location: ™

Notes:

Save Cancel

Surgery/Hospitalization: [+

Date:w
Physician: ™
Location:

Instructions: [»

Notes:
Save Cancel

Insurance: store information on all types of insurance; saves records to a
master list for use in other profiles.

Multiple entries can be saved per profile. A list screen is available for easy
viewing and finding of a certain entry in the list.

Contacts: store emergency contact information; saves records to a master
list for use in other profiles.

Multiple entries can be saved per profile. A list screen is available for easy
viewing and finding of a certain entry in the list.

Allergies: store information on any allergies for the personal profile.

Multiple entries can be saved per profile. A list screen is available for easy
viewing and finding of a certain entry in the list.

llinesses, etc: store information on previous illness, diseases, or
conditions including symptoms, diagnosis, treatment, etc.

Multiple entries can be saved per profile. A list screen is available for easy
viewing and finding of a certain entry in the list.

Surgeries, etc: store information on previous surgeries or hospitalizations
including date, instructions, etc.

Multiple entries can be saved per profile. A list screen is available for easy
viewing and finding of a certain entry in the list.
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Appointments

Physician: ™
Date:w
Location: ™
Reason:

Time: *

Diagnosis:

Treatment:
Notes:
Follow-Up Visit:
Date:w

V=

Time: ™

vied (] DN
Medication:
Take:
Dosage:
Physician: ™

Start Date: ™™

Stop Date: *

Purpose: [
Pharmacy: ™

Rx #:

Active: ™ Yes

Notes: [+

Save Cancel

i nl ph
Name: My Name
02/23/2004 DTaP
02/17/2004 HepB
02/17/2004 Hib

Test:
Date:w
Physician: ™
Location: ™
Result: [

Goal: [+

Notes: [+

Save Cancel
Blood Pressure

Name: My Name

02/23 02:43P 130/70(P 64)
02/17 08:41P 120/70 (P 65)
02/11 04:41P 135/80(P 70}

New

Appointments: store information on any appointment, including date, time,
reason, diagnosis, follow-up date, etc.

Multiple entries can be saved per profile. A list screen is available for easy
viewing and finding of a certain entry in the list.

Medications: store information on medications or vitamins being taken, or
previously taken, and prescription details.

Multiple entries can be saved per profile. A list screen is available for easy
viewing and finding of a certain entry in the list.

Vaccinations: store information on shots and vaccinations, including date,
physician, etc. In this example, the details screen is not shown.

Multiple entries can be saved per profile. A list screen shown to the left is
available for most topics. This allows for easy viewing and finding of a
certain entry in the list.

Tests: store information on any kind of test or exam, including result, goal,
physician, location, etc.

Multiple entries can be saved per profile. A list screen is available for easy
viewing and finding of a certain entry in the list.

Blood Pressure: store blood pressure test results, including pulse, date,
time, activity, etc. In this example, the details screen is not shown.

Multiple entries can be saved per profile. A list screen shown to the left is

available for most topics. This allows for easy viewing and finding of a
certain entry in the list.
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Weight:
Date:w02/23/2004 Time: ¥2:50PM
Notes: [

Insulin:

Date:¥08/11/2005 Time: ¥ 10:03 AM
Notes: [ 3

HDL: ...
Triglycerides: .
Date:'¥08/11/2005 Time: ¥ 10:02 AM

Notes: [ 3

First: Last:
Relation: ™

Side: ™

Birthdate:w

Deceased: ™™
llinesses/Diseases/Conditions: [

Notes: [

Preferences Screen:

Currency Symbol:§
Date Format: ™ mmddyyyy Sep: ™/
Glucose Units: " mg/dL
M Backup Databases on Hotsync
[ Confirm Delete Operations

((Set/Change Password )

Weight: store weight measurements, including date, time, and notes.

Multiple entries can be saved per profile. A list screen is available for easy
viewing and finding of a certain entry in the list.

Glucose: store blood sugar test results, including carbs, insulin amount,
date, time, event, etc.

Multiple entries can be saved per profile. A list screen is available for easy
viewing and finding of a certain entry in the list.

Cholesterol: store total, LDL, HDL, triglycerides, date, time, note, etc.

Multiple entries can be saved per profile. A list screen is available for easy
viewing and finding of a certain entry in the list.

Family History: store family history information to record illnesses and
conditions of related family members.

Multiple entries can be saved per profile. A list screen is available for easy
viewing and finding of a certain entry in the list.

The Preferences screen allows the user to customize several items.

The currency symbol can be specific, as well as the date format and date
separator (mm/dd/yyyy, etc.). The default glucose units can also be
selected. Options can be turned on or off for backing up the Palm OS
databases and confirming delete operations.

Tapping the Set/Change Password button allows the password to be
changed.

Page 5 - Copyright 2001-2010 WakefieldSoft, LLC.



Setting or Changing the Password:

For additional security, a password can be used. To set or change the
e Fassword: password, tap the Password button on the Preferences screen.
RetypePassword:
Enter the old password if one exists, then enter the new password and
:f ’
(3) retyped password. The [@bclbutton will bring up the on screen keyboard
() (58] for easier text entry (Palm OS only). The Bksp button will backspace one

ERIERED character.

(L0 (abe] (e

B Hide Input HealthFile data is not encrypted, but the password does prevent

unauthorized users from viewing your information.

Menu Options:

A menu system is available to perform additional functions on the handheld. To view the menu
system, tap the Menu silkscreen icon (just below the Home silkscreen icon). Also, the title bar for the
application can be tapped while the application is running to display the menu system.

File Menu: RIEEH Edit Help )

xport Data to Memo |

The File menu offers the following options:
Export Date to Memo/Note - while viewing information details, select this
option to export the information as text to a new.

Edit Menu: File |21 Help B

E:It I(Iontuct Llft
it Insurance List
The Edit menu offers the following options: E::: ";:;m:: LiLsi:t
Edit Contact List - allows the user to edit the Master Contact List that can Edit p,.,vi.,e,’.'_i,t
be used for any personal profile. Edit Provider Type List
Edit Insurance List - allows the user to edit the Master Insurance List that E::y j’c‘
can be used for any personal profile. Paste /P
Edit Location List - allows the user to edit the Master Location List that On Screen Keyboard

can be used for specifying locations in different topics.

Edit Pharmacy List - allows the user to edit the Master Pharmacy List
that can be used for selecting pharmacies in Medications.

Edit Provider List - allows the user to edit the Master Provider List of
providers (physicians, etc.) that can be used to select a Provider in
different topics.

Edit Provider Type List - allows the user to edit the Master Provider Type
List that can be used for specifying a provider type in the Master
Provider List.

Cut/Copy/Paste - standard functions.

On Screen Keyboard - this menu option will display the on screen
keyboard for entering text or numbers. This is useful for handhelds
that do not have a virtual graffiti area.

Help Menu: [File Edit G103 ]

Help...
About...|

The Help menu offers the following options:
Help - selecting this option will display the handheld help file.
About - selecting this option will display the About screen.
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HealthFile Desktop:

The PC software includes all of the features on the handheld software, plus other features specific to
the desktop software. Features available only on the desktop software include: printing selected
records, printing all records, importing records from delimited text files (CSV, etc.), exporting records
to a CSV file, and more. Consult the help file on the PC desktop software for further information on the

desktop features.

Conclusion:
If you are just evaluating or have already purchased HealthFile - Thanks!

If you have questions about the software, or cannot find an answer to a problem at our site, please
email our support staff. We will work hard to resolve your issue and answer your questions.
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